HP ProBook 5330m Notebook PC

Maintenance and Service Guide

SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.
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Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description
Product Name HP ProBook 5330m Notebook PC
Processors Intel® Core™ processors

e Intel Core i3-2310M, Dual-Core, 2.10 GHz, 3 MB L3 cache, 4 threads (35 W)

e Intel Core i5-2520M, Dual-Core, 2.50 GHz (Turbo up to 3.20 GHz), 3 MB L3
cache, 4 threads (35 W)

Chipset Mobile Intel QM67

Graphics Intel HD Graphics 3000

Universal Memory Architecture (UMA) graphics subsystem integrated with shared
video memory (dynamically allocated)

Panels All display panel assemblies support privacy filter

LED backlight

33.8 cm (13.3 in) High-Definition (HD) AntiGlare LED display (1280x800) with
webcam

Memory 2 customer-accessible/upgradable SODIMM memory module slots

Supports dual-channel memory

Supports up to 8 GB of system memory

DDR3 PC3-10600 SDRAM (1333 MHz)

Supports the following configurations:

e  8192-MB total system memory (4096-MB x 2, dual-channel)

e  6144-MB total system memory (4096-MB + 2048-MB, dual channel)
e  4096-MB total system memory (4096-MB x 1)

e  4096-MB total system memory (2048-MB x 2, dual-channel)

e  3072-MB total system memory (2048-MB + 1024-MB, dual-channel)
e  2048-MB total system memory (2048-MB x 1)

Hard drives Supports 9.5-mm or 7mm, 6.35 cm (2.50 in) hard drives

Customer-accessible

Serial ATA (SATA)
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Category

Description

Supports the following hard drives:

e 500 GB, 7200-rpm

e 320 GB Self-Encrypting Drive (SED), 7200-rpm
e 320 GB, 7200-rpm

e 250 GB, 7200-rpm

Supports the following solid-state drive:

e 128GB

HP 3D DriveGuard (not available with Linux)

Audio/Visual

Beats audio

Integrated microphone (dual-array)

Two stereo speakers

Integrated 720p webcam

Ethernet

10/100/1000 Ethernet network interface card (NIC)

S3/S4/S5 wake on LAN (AC only mode)

Wireless

Integrated WLAN options by way of wireless module

Support for the following WLAN formats:

e  Broadcom 43224 802.11a/b/g/n WiFi Adapter

e  Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter

e Intel Centrino® Advanced N 6205 802.11a/b/g/n, 2x2 WiFi Adapter

2 WLAN antennas built into display assembly

Support for no-WLAN option

Integrated personal area network (PAN) options by way of Bluetooth®
module:

Support for no-WPAN option

HP Integrated Module with Bluetooth 2.1 Wireless Technology

Integrated WWAN options by way of WWAN module (not available with Linux)

HP un2430 EV-DO/HSPA Mobile Broadband Module (select models only)

HP hs2340 HSPA+ Mobile Broadband Module

Support for no-WWAN option

Subscriber identity module (SIM) security (customer-accessible in battery bay)

External media cards

Integrated SD flash media slot supporting Secure Digital (SD) and MultiMediaCard
(MMC)

Ports

Audio in/Audio-out (stereo microphone/headphone)

RJ-45 (Ethernet, includes link and activity lights)

USB 2.0 (2), one with USB charging

Combo eSATA/USB 2.0 (1)

Chapter 1 Product description



Category

Description

HDMI

VGA (Dsub 15-pin) supporting 1600%1200 external resolution at 75 GHz (hot plug/
unplug with auto-detect)

Multi-pin AC power

Keyboard and pointing devices

Backlit keyboard with TouchPad

TouchPad with 2 TouchPad buttons and vertical scrolling (taps and gestures
enabled as default)

Power requirements

65-W AC adapter with localized cable plug support (3-wire plug with ground pin)

4-cell, 41-Wh 2.8-Ah Li-ion battery

Security

Supports security lock

Intel AT support

Integrated fingerprint reader

Full volume encryption

TPM 100% attach

HP face recognition

Privacy filter

Preboot authentication (password, smart card)

Operating systems

Preinstalled operating systems:

e  Windows Vista® Basic 32-bit with MS Basic (Japan only)

e  Windows® 7 Home Premium 32-bit with MS Basic (Japan only)
e  Windows 7 Home Premium 64-bit with MS Basic (Japan only)
e  Windows 7 Professional 32-bit with MS Basic (Japan only)

e  Windows 7 Professional 64-bit with MS Basic (Japan only)

e  FreeDos

e  SuSE Linux (SLED11)
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Category

Description

Preinstalled Windows operating systems, plus Microsoft® Office:

Windows Vista Home Basic 32-bit with Office Starter (excludes Japan,
selected localizations only)

Windows 7 Home Basic 32-bit with Office Starter (selected localizations only)
Windows 7 Home Basic 64-bit with Office Starter (selected localizations only)
Windows 7 Home Premium 32-bit with Office 2010 Starter (excludes Japan)
Windows 7 Home Premium 32-bit with Office 2010 Personal (Japan only)

Windows 7 Home Premium 32-bit with Office 2010 Home & Business (Japan
only)

Windows 7 Home Premium 32-bit with Office 2010 Professional (Japan only)
Windows 7 Home Pemium 64-bit with Office 2010 Starter (excludes Japan)
Windows 7 Home Premium 64-bit with Office 2010 Personal (Japan only)

Windows 7 Home Premium 64-bit with Office 2010 Home & Business (Japan
only)

Windows 7 Home Premium 64-bit with Office 2010 Professional (Japan only)
Windows 7 Professional 32-bit with Office 2010 Starter (excludes Japan)
Windows 7 Professional 32-bit with Office 2010 Personal (Japan only)

Windows 7 Professional 32-bit with Office 2010 Home & Business (Japan
only)

Windows 7 Professional 32-bit with Office 2010 Professional (Japan only)
Windows 7 Professional 64-bit with Office 2010 Starter (excludes Japan)
Windows 7 Professional 64-bit with Office 2010 Personal (Japan only)

Windows 7 Professional 64-bit with Office 2010 Home & Business (Japan
only)

Windows 7 Professional 64-bit with Office 2010 Professional (Japan only)

Restore media:

Windows 7 Home Basic 32-bit
Windows 7 Home Basic 64-bit
Windows 7 Home Premium 32-bit
Windows 7 Home Premium 64-bit
Windows 7 Professional 32-bit
Windows 7 Professional 64-bit

DRDVD Windows 7

Certified:

Microsoft WHQL
SuSE Linux/Novell

Chapter 1 Product description



Category

Description

Web-only support:

Windows XP Professional 32-bit
Windows 7 Enterprise 32/64
Windows 7 Ultimate

Serviceability

End-user replaceable parts:

Battery (system)
Memory module
WLAN module
WWAN module
Hard drive

Keyboard
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2 External component identification

Top
TouchPad

il
a_
97

Component Description

(1) TouchPad on/off button Turns the TouchPad on and off.

(2) TouchPad Moves the pointer and selects or activates items on the
screen.

3) Left TouchPad button Functions like the left button on an external mouse.

(4) Right TouchPad button Functions like the right button on an external mouse.

Chapter 2 External component identification



Lights

= |
I
: t
(5] o
Component Description
(1) {l_} Power light e  On: The computer is on.
e  Blinking: The computer is in the Sleep (Suspend in
Linux) state.
e  Off: The computer is off or in Hibernation.
(2) Wireless light e  White: An integrated wireless device, such as a

)

wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

e  Amber: All wireless devices are off.

()

QuickWeb light

e  On: The computer is on.
e  Blinking (in Linux): The Web browser is loading.
e  Off: The computer is off or in Hibernation.

NOTE: For more Windows information, refer to the HP
QuickWeb software Help.

(4)

Mute light

e  Amber: Computer sound is off.

e  Off: Computer sound is on.

5

Caps lock light

On: Caps lock is on.

(6)

TouchPad light

e  Amber: The TouchPad is off.
e  Off: The TouchPad is on.

Top
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Buttons and fingerprint reader

]
l

(5

Component

Description

(1) {IJ' Power button

When the computer is off, press the button to turn on the
computer.

When the computer is on, press the button briefly to initiate
Sleep (Suspend in Linux).

When the computer is in the Sleep (Suspend in Linux) state,
press the button briefly to exit Sleep (Suspend).

When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and operating system
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.

To learn more about your power settings:

Windows 7—Select Start > Control Panel > System and
Security > Power Options.

—or—

Windows Vista—Select Start > Control Panel > System
and Maintenance > Power Options.

Refer to the HP Notebook Reference Guide.

Linux—Select Computer > Control Center. In the left pane,
click System, and then click Power Management in the right
pane.

Chapter 2 External component identification



Component

Description

()

)

Wireless button

Turns the wireless feature on or off but does not establish a
wireless connection.

(3) @ QuickWeb button

In Windows:

When the computer is off or in Hibernation, press the button to
open HP QuickWeb.

When the computer is in Microsoft Windows, press the button
to open the default Web browser.

When the computer is in HP QuickWeb, press the button to
open the default Web browser.

NOTE: For more information, refer to the HP QuickWeb software
Help. If your computer does not have HP QuickWeb software, the
button does not perform any action or function.

In Linux:

When the computer is on, press the button to open the default
Web browser.

NOTE: Pressing the QuickWeb button a second time opens
a second browser window.

When the computer is off, in the Suspend state, orin
Hibernation, the button does not perform any action or
function.

(4)

de

Volume mute button

Mutes and restores speaker sound.

5

Fingerprint reader

Allows a fingerprint logon to the operating system, instead of a
password logon.

Top
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Component

Description

(1

esc key

In Windows, displays system information when pressed in
combination with the fn key.

)

fn key

In Windows, executes frequently used system functions
when pressed in combination with a function key, the num
Ik key, or the esc key. In Linux, executes frequently used
system functions when pressed in combination with a
function key.

@)

Windows logo key

In Windows, displays the Windows Start menu.

(4)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

5

Windows applications key

In Windows, displays a shortcut menu for items beneath
the pointer.

(6)

Embedded numeric keypad

When the keypad is turned on, it can be used like an
external numeric keypad. Each key on the keypad
performs the function indicated by the icon in the upper-
right corner of the key.

@)

num Ik key

Turns the embedded numeric keypad on and off when
pressed in combination with the fn key.

10 Chapter 2 External component identification



Front

T
- il
Component Description
(1) m Power light e  On: The computer is on.
e  Blinking: The computer is in the Sleep (Suspend
in Linux) state.
e  Off: The computer is off or in Hibernation.
(2) ﬂ Hard drive light e  Blinking white: The hard drive is being accessed.
e  Amber: HP 3D DriveGuard has temporarily
parked the hard drive.
NOTE: For information on HP 3D DriveGuard, refer
to the HP Notebook Reference Guide.
(3) Speakers (2) Produce sound.

Front
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Right

e ¢

-ﬁ

&

@ ©

Component

Description

Audio-out (headphone) jack/Audio in

(1 io-
(microphone) jack
-

Connects optional powered stereo speakers, headphones,
earbuds, a headset, or television audio. Also connects an
optional headset microphone.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety, and Environmental Notices.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor
connector that supports both audio-out (headphone) and
audio in (microphone).

(2) i Charging USB port Connects an optional USB device and can also charge
= select models of cell phones and MP3 players, even when
the computer is off.

(3) e Powered USB port Connects a optional USB device and provides more
current (up to 3 A) than a standard USB port (only up to
500mA).

(4) T RJ-45 (network) lights (2) e  Green (left): The network is connected.

e  Amber (right): The network is showing activity.

(5) T RJ-45 (network) jack Connects a network cable.

(6) Q Power connector Connects an AC adapter.

(7) Battery light e  Amber: The computer is connected to external power

and the battery is charged from 0 to 90 percent.

e  White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

e  Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

e  Off: The battery is fully charged.

12 Chapter 2 External component identification



Left

4

@

=]

e

© ®

Component

Description

()

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

()

Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(©)

External monitor port

Connects an external VGA monitor or projector.

=
(4) S5ATA eSATA/USB port Connects a high-performance eSATA component, such as
L= an eSATA external hard drive, or connects an optional USB
device.
(5) , HDMI port Connects an optional video or audio device, such as a

high-definition television, or any compatible digital or audio
component.

(6)

Media Card Reader

Supports the following digital card formats:
e  MultiMediaCard

e  Secure Digital (SD) Memory Card

Left
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Display

T — —

Component Description

1) Internal display switch Turns off the display or initiates Sleep (Suspend in Linux) if the
display is closed while the power is on.
NOTE: The display switch is not visible from the outside of the
computer.

(2) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3) WWAN antennas (2)* Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(4) Internal microphones (2) Record sound.

(5) Webcam light On: The webcam is in use.

(6) Webcam Records video and captures still photographs.

To use the webcam:

e In Windows, select Start > All Programs > HP >
HP Webcam.

e In Linux, select Computer > More Applications >
Cheese.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

14 Chapter 2 External component identification



Bottom

Component

Description

(1)

Battery bay

Holds the battery.

()

Battery cover release
latch

Releases the battery cover over the battery bay.

()

Vents (2)

Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(4)

Bluetooth compartment

Contains a Bluetooth device.

()

SIM slot

Supports a wireless subscriber identity module (SIM). The SIM slot
is located inside the battery bay.

(6)

Sm

Hard drive bay and
wireless and memory
module compartments

Holds the hard drive, the WLAN module slot, the WWAN module
slot, and the memory module slots.

CAUTION: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for use in
the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and
then receive a warning message, remove the module to restore
computer functionality, and then contact technical support.

Bottom 15



3 lllustrated parts catalog

Serial number label location

When you order parts or request information, the serial number label, located inside the battery bay,
provides important information that you may need when contacting technical support.

?

]

|
RN, XK

3

Seriat: 00000000 NI NNAAA A E IR

Product xco00coaeocd ||| NN IRIRINTI

= Warranty: XyxyRy

Component

Description

0

Product name

The product name affixed to the front of your
computer.

(2

Serial number

An alphanumeric identifier that is unique to each
product.

@)

Product part number

The identifier that provides specific information about
the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

4

Warranty

The duration of the warranty period for this computer.

16 Chapter 3
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Computer major components
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Item Description Spare part number

(1) 33.8 cm (13.3 in) HD AntiGlare LED display (1280x800) 650397-001

NOTE: The WLAN antennas and cables and the WWAN antennas and cables are included
in the Antenna Kit, spare part number 650365-001.

(2) Keyboard

e  For use in Adriatic countries 650377-BA1
e  For use in Africa—French/Arabic 650377-DW1
e  For use in Belgium 650377-A41
e  For use in Bulgaria 650377-261
e  For use in the Czech Republic and Slovakia 650377-A81
e  Foruse in Denmark 650377-081
e Forusein France 650377-051
e  Foruse in French Canada 650377-121
e  Foruse in Germany 650377-041
e Forusein Greece 650377-DJ1
e  Foruse in Hungary 650377-211
e Forusein Iceland 650377-DD1
e  For International use 650377-B31
e Forusein Israel 650377-BB1
e  Forusein Italy 650377-061
e  Foruse in Japan 650377-291
e  Foruse in Latin America 650377-161
e  Foruse in Norway 650377-091
e  For use in Portugal 650377-131
e Forusein Russia 650377-251
e  Foruse in Saudi Arabia 650377-171
e  Foruse in South Korea 650377-AD1
e  Foruse in Spain 650377-071
e  Foruse in Sweden and Finland 650377-B71
e  For use in Switzerland 650377-BG1
e Forusein Taiwan 650377-AB1
e  Foruse in Thailand 650377-281
e  Foruse in Turkey 650377-141
e  For use in the United Kingdom 650377-031
e  Foruse in the United States 650377-001
(3) Fan 650371-001

18 Chapter 3 lllustrated parts catalog



Item  Description Spare part number
(4) Top cover
e  With fingerprint reader 651761-001
e  Without fingerprint reader 650404-001
(5) Power button board (includes cable) 650392-001
(6) Activity button board (includes cable) 650393-001
(7) Audio board (includes cable) 650394-001
(8) Power connector bracket (included with the power connector cable)
9) RTC battery 650398-001
(10)  Power connector cable
NOTE: The power connector cable is included in the Cable Kit, spare part number
650369-001. See Cable Kit on page 23 for more Cable Kit spare part information.
(11) System board (includes processor and replacement thermal material)
e Includes Intel Core i3-2310M, Dual-Core, 2.10 GHz, 3 MB L3 cache, 4 threads (35 W)— 650402-001
for all countries except Russia and the People's Republic of China
e Includes Intel Core i5-2520M, Dual-Core, 2.50 GHz (Turbo up to 3.20 GHz), 3 MB L3 650403-001
cache, 4 threads (35 W)—for all countries except Russia and the People's Republic of
China
e Includes Intel Core i3-2310M, Dual-Core, 2.10 GHz, 3 MB L3 cache, 4 threads (35 W)— 656796-001
for Russia and the People's Republic of China only
e Includes Intel Core i5-2520M, Dual-Core, 2.50 GHz (Turbo up to 3.20 GHz), 3 MB L3 656797-001
cache, 4 threads (35 W)—for Russia and the People's Republic of China only
(12)  Heat sink 650372-001
(13) Speakers 650400-001
(14) Base enclosure 650367-001
(15)  SD Card blank
NOTE: The SD Card blank is included in the Plastics Kit, spare part number 650395-001.
See Plastics Kit on page 22 for more Plastics Kit spare part information.
(16)  Bluetooth module (select models only) 537921-001
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is included in the Cable Kit, spare part number 650369-001. See
Cable Kit on page 23 for more Cable Kit spare part information.
(17)  Battery (4-cell, 41 Wh, 2.8 Ah, Li-on) 635146-001
(18) Fan plate
NOTE: The fan plate is included with the fan kit, spare part number 650371-001.
(19) SATA 6.35 cm (2.50 in) hard drive

NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number 650373-001.

9.5 mm hard drives

e 500 GB, 7200-rpm 634925-001

e 320 GB, 7200-rpm, Self Encrypting 626978-001

Computer major components
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Item Description Spare part number
e 320 GB, 7200-rpm 641672-001
e 250 GB, 7200-rpm 635225-001
7-mm hard drives
e 320 GB, 7200-rpm Self Encrypting 641674-001
e 320 GB, 7200-rpm 634862-001
e 250 GB, 7200-rpm 634861-001
Solid-state drive
e 128GB 650401-001

(200 WWAN module (not available with Linux)

HP hs2340 HSPA+ Mobile Broadband Module 632155-001
HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

(21)  WLAN module
Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter for use in Australia, Bangladesh, Bhutan, 593836-001
Brunei, Cambodia, East Timor, Fiji, Hong Kong, India, Indonesia, Japan, Kiribati, Laos,

Malaysia, Maldives, Marshall Islands, Micronesia, Nauru, Nepal, New Zealand, Pakistan,

Palau, Papua New Guinea, the People's Republic of China, the Philippines, Samoa,

Singapore, Solomon Islands, South Korea, Sri Lanka, Taiwan, Thailand, Tonga, Tuvalu, and

Vietnam

Broadcom 43224 802.11a/b/g/n WiFi Adapter for use in Antigua and Barbuda, Barbados, 582564-001
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S.

Virgin Islands, and the United States

Broadcom 43224 802.11a/b/g/n WiFi Adapter for use in Albania, Algeria, Angola, Argentina,  582564-002
Australia, Austria, Bahrain, Bangladesh, Belarus, Belgium, Benin, Bolivia, Botswana, Brunei,

Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African

Republic, Chad, Chile, Colombia, the Congo, Costa Rica, Croatia, Cyprus, the Czech

Republic, Denmark, Djibouti, Dominica, Dominican Republic, Ecuador, Egypt, El Salvador,

Equitorial Guinea, Estonia, Finland, France, Gabon, Gambia, Germany, Ghana, Gibraltar,

Greece, Guinea, Guinea-Bissau, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland,

Italy, the Ivory Coast, Japan, Grenada, Guatemala, Guyana, Honduras, Jordan, Kenya,

Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg,

Madagascar, Malaysia, Mali, Mauritania, Mauritius, Mexico, Morocco, Mozambique, Namibia,

Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,

Panama, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal,

Puerto Rico, Qatar, Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia,

Senegal, Serbia and Montenegro, Sierra Leone, Singapore, Slovakia, Slovenia, South Africa,

South Korea, Spain, Sri Lanka, Suriname, Sweden, Switzerland, Taiwan, Tanzania,

Thailand, Togo, Tunisia, Turkey, Ukraine, the United Arab Emirates, the United Kingdom,

Uruguay, Venezuela, Vietnam, Yemen, and Zimbabwe

Intel Centrino® Advanced N 6205 802.11a/b/g/n, 2x2 WiFi Adapter 631954-001

(22) Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared)

4096 MB 621568-001
2048 MB 581096-001
1024 MB 639736-001
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Item

Description Spare part number

(23)

Service access cover

NOTE: The service access cover is included in the Plastics Kit, spare part number
650395-001. See Plastics Kit on page 22 for more Plastics Kit spare part information.

(24

Battery cover

NOTE: The battery cover is included in the Plastics Kit, spare part number 650395-001.
See Plastics Kit on page 22 for more Plastics Kit spare part information.

Display assembly components

Item  Description Spare part number
(1) Display bezel 650368-001
(2) 33.8 cm (13.3 in) HD AntiGlare LED display (1280x800) 650397-001
(3) Display Hinge Kit (includes left and right display hinges) 650374-001

Display assembly components
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Item  Description Spare part number
(4) Hinge covers 650376-001
(5) Display cable (includes microphone and webcam connector) 650370-001
(6) WLAN antennas and cables (included with the Antenna Kit, spare part number
650365-001)
(7) WWAN antennas and cables (included with the Antenna Kit, spare part number
650365-001)
(8) Webcam module 650405-001
9) Display back cover 650366-001

Plastics Kit

Item  Description Spare part number
Plastics Kit: 650395-001

1) Service access cover

(2) Battery cover

3) SD Card blank
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Cable Kit

Item Description Spare part number
Cable Kit: 650369-001

(1) Bluetooth cable

(2) TouchPad cable

(3) Power cable

Cable Kit
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Mass storage devices

Item Description

Spare part number

1) Hard drive bracket

NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part
number 650373-001.

(2) Solid-state drive (128 GB) 650401-001
3) SATA 6.35-cm (2.5 in) hard drive
9.5 mm hard drives
e 500 GB, 7200-rpm 634925-001
e 320 GB, 7200-rpm, Self Encrypting 626978-001
e 320 GB, 7200-rpm, 641672-001
e 250 GB, 7200-rpm 635225-001
7-mm hard drives
e 320 GB, 7200-rpm, Self Encrypting 641674-001
e 320 GB, 7200-rpm 634862-001
e 250 GB, 7200-rpm 634861-001
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Miscellaneous parts

Description

Spare part number

AC adapters

65 W, 3-pin Smart AC Adapter (for use in all countries and regions except Australia, Bangladesh, = 609939-001
Brunei, Cambodia, Hong Kong, India, Indonesia, Japan, Laos, Malaysia, Nepal, New Zealand,

Pakistan, the People's Republic of China, the Philippines, Singapore, South Korea, Sri Lanka,

Taiwan, Thailand, Vietnam)

65 W, 3-pin Slim AC Adapter (for use in only Australia, Bangladesh, Brunei, Cambodia, Hong 609948-001
Kong, India, Indonesia, Japan, Laos, Malaysia, Nepal, New Zealand, Pakistan, the People's

Republic of China, the Philippines, Singapore, South Korea, Sri Lanka, Taiwan, Thailand,

Vietnam)

Power cords (AC power, 3-pin, black, 1.83-m)

e  Foruse in Australia 490371-011
e  Foruse in Argentina 490371-D01
e  Foruse in Denmark 490371-081
e  Foruse in Europe 490371-021
e Forusein India 490371-D61
e  Forusein Israel 490371-BB1
e Forusein ltaly 490371-061
° For use in Japan 490371-291
e  Foruse in North America 490371-001
e  For use in the People's Republic of China 490371-AA1
e  Foruse in South Africa 490371-AR1
e  Foruse in South Korea 490371-AD1
e  Foruse in Switzerland 490371-111
e  Foruse in Taiwan 490371-AB1
e  Foruse in Thailand 490371-201
e  Foruse in the United Kingdom and Singapore 490371-031
Screw Kit-includes: 650399-001

e  Phillips M2.0x5.0
e  Phillips M2.5x2.0
o  Pnhillips M2.5x3.0
e  Pnhillips M2.5x4.0
e  Phillips M3.0x3.5

Miscellaneous parts
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Sequential part number listing

Spare part
number

Description

490371-001

Power cord (AC power, 3-pin, black, 1.83-m), for use in North America

490371-011

Power cord (AC power, 3-pin, black, 1.83-m), for use in Australia

490371-021

Power cord (AC power, 3-pin, black, 1.83-m), for use in Europe

490371-031

Power cord (AC power, 3-pin, black, 1.83-m), for use in the United Kingdom and Singapore

490371-061

Power cord (AC power, 3-pin, black, 1.83-m), for use in Italy

490371-081

Power cord (AC power, 3-pin, black, 1.83-m), for use in Denmark

490371-111

Power cord (AC power, 3-pin, black, 1.83-m), for use in Switzerland

490371-201

Power cord (AC power, 3-pin, black, 1.83-m), for use in Thailand

490371-291

Power cord (AC power, 3-pin, black,1.83-m), for use in Japan

490371-AA1

Power cord (AC power, 3-pin, black, 1.83-m), for use in the People's Republic of China

490371-AB1

Power cord (AC power, 3-pin, black, 1.83-m), for use in Taiwan

490371-AD1

Power cord (AC power, 3-pin, black,1.83-m), for use in South Korea

490371-AR1

Power cord (AC power, 3-pin, black,1.83-m), for use in South Africa

490371-BB1

Power cord (AC power, 3-pin, black,1.83-m), for use in Israel

490371-D01

Power cord (AC power, 3-pin, black,1.83-m), for use in Argentina

490371-D61

Power cord (AC power, 3-pin, black, 1.83-m), for use in India

537921-001

Bluetooth module (without cable). The Bluetooth cable is included in the Cable Kit, spare part number
650369-001.

581096-001

Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared), 2048-MB

582564-001

Broadcom 43224 802.11a/b/g/n WiFi Adapter for use in Antigua and Barbuda, Barbados, Belize, Canada,
the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United
States

582564-002

Broadcom 43224 802.11a/b/g/n WiFi Adapter for use inAlbania, Algeria, Angola, Argentina, Australia,
Austria, Bahrain, Bangladesh, Belarus, Belgium, Benin, Bolivia, Botswana, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, Dominican
Republic, Ecuador, Egypt, El Salvador, Equitorial Guinea, Estonia, Finland, France, Gabon, Gambia,
Germany, Ghana, Gibraltar, Greece, Guinea, Guinea-Bissau, Hong Kong, Hungary, Iceland, India,
Indonesia, Ireland, ltaly, the Ivory Coast, Japan, Grenada, Guatemala, Guyana, Honduras, Jordan, Kenya,
Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg, Madagascar,
Malaysia, Mali, Mauritania, Mauritius, Mexico, Morocco, Mozambique, Namibia, Nepal, the Netherlands,
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, the People's
Republic of China, Peru, the Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, Russia,
Rwanda, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and Montenegro, Sierra Leone,
Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Suriname, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Togo, Tunisia, Turkey, Ukraine, the United Arab Emirates, the
United Kingdom, Uruguay, Venezuela, Vietham, Yemen, and Zimbabwe
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Spare part Description

number

593836-001 Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter for use in Australia, Bangladesh, Bhutan, Brunei,
Cambodia, East Timor, Fiji, Hong Kong, India, Indonesia, Japan, Kiribati, Laos, Malaysia, Maldives,
Marshall Islands, Micronesia, Nauru, Nepal, New Zealand, Pakistan, Palau, Papua New Guinea, the
People's Republic of China, the Philippines, Samoa, Singapore, Solomon Islands, South Korea, Sri Lanka,
Taiwan, Thailand, Tonga, Tuvalu, and Vietnam

609939-001 65 W, 3-pin Smart AC Adapter (for use in all countries and regions except Australia, Bangladesh, Brunei,
Cambodia, Hong Kong, India, Indonesia, Japan, Laos, Malaysia, Nepal, New Zealand, Pakistan, the
People's Republic of China, the Philippines, Singapore, South Korea, Sri Lanka, Taiwan, Thailand,
Vietnam)

609948-001 65 W, 3-pin Slim AC Adapter (for use in only Australia, Bangladesh, Brunei, Cambodia, Hong Kong, India,
Indonesia, Japan, Laos, Malaysia, Nepal, New Zealand, Pakistan, the People's Republic of China, the
Philippines, Singapore, South Korea, Sri Lanka, Taiwan, Thailand, Vietnam)

621568-001 Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared), 4096-MB

626978-001 9.5 mm hard drive, 320 GB, 7200-rpm, Self-Encrypting

631954-001 Intel Centrino® Advanced N 6205 802.11a/b/g/n, 2x2 WiFi Adapter

632155-001 HP hs2340 HSPA+ Mobile Broadband Module

634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module (select models only)

634861-001 7 mm hard drive, 250 GB, 7200-rpm

634862-001 7 mm hard drive, 320 GB, 7200-rpm

634925-001 9.5 mm hard drive, 500 GB, 7200-rpm

635146-001 Battery, 4-cell, 41-Wh (2.8-Ah) Li-ion

635225-001 9.5 mm hard drive, 250 GB, 7200-rpm

639736-001 Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared), 1024-MB

641672-001 9.5 mm hard drive, 320 GB, 7200-rpm

641674-001 7-mm hard drive, 320 GB, 7200-rpm, Self Encrypting

650365-001 Antenna Kit

650366-001 Display back cover

650367-001 Base enclosure

650368-001 Display bezel

650369-001 Cable Kit (See Cable Kit on page 23 for more Cable Kit spare part information.)

650370-001 Display cable (includes microphone and webcam connector)

650371-001 Fan

650372-001 Heat sink

650373-001 Hard Drive Hardware Kit

650374-001 Display Hinge Kit (includes left and right display hinges)

650376-001 Display hinge covers

650377-001 Keyboard for use in the United States

650377-031 Keyboard for use in the United Kingdom
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Spare part Description

number

650377-041 Keyboard for use in Germany
650377-051 Keyboard for use in France
650377-061 Keyboard for use in Italy
650377-071 Keyboard for use in Spain
650377-081 Keyboard for use in Denmark
650377-091 Keyboard for use in Norway
650377-121 Keyboard for use in French Canada
650377-131 Keyboard for use in Portugal
650377-141 Keyboard for use in Turkey
650377-161 Keyboard for use in Latin America
650377-171 Keyboard for use in Saudi Arabia
650377-211 Keyboard for use in Hungary
650377-251 Keyboard for use in Russia
650377-261 Keyboard for use in Bulgaria
650377-281 Keyboard for use in Thailand
650377-291 Keyboard for use in Japan
650377-A41 Keyboard for use in Belgium
650377-A81 Keyboard for use in the Czech Republic and Slovakia

650377-AB1 Keyboard for use in Taiwan

650377-AD1 Keyboard for use in South Korea

650377-B31 Keyboard for International use

650377-B71 Keyboard for use in Sweden and Finland

650377-BA1 Keyboard for use in Adriatic countries

650377-BB1 Keyboard for use in Israel

650377-BG1 Keyboard for use in Switzerland

650377-DD1 Keyboard for use in Iceland

650377-DJ1 Keyboard for use in Greece

650377-DWA1 Keyboard for use in Africa—French/Arabic

650392-001 Power button board with cable

650393-001 Activity button board with cable

650394-001 Audio board (includes cable)

650395-001 Plastics Kit (includes service access cover, battery cover, and SD Card blank)
650397-001 33.8 cm (13.3 in) HD AntiGlare LED display (1280x800)
650398-001 RTC battery
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Spare part Description

number

650399-001 Screw Kit (See Miscellaneous parts on page 25 for more Screw Kit spare part information.)

650400-001 Speaker assembly

650401-001 Solid-state drive, 6.35 cm (2.5 in), 128 GB

650402-001 System board (includes Intel Core i3-2310M, Dual-Core, 2.10 GHz, 3 MB L3 cache, 4 threads (35 W) and
replacement thermal material)—for all countries except Russia and the People's Republic of China

650403-001 System board (includes Intel Core i5-2520M, Dual-Core, 2.50 GHz (Turbo up to 3.20 GHz), 3 MB L3
cache, 4 threads (35 W) and replacement thermal material)—for all countries except Russia and the
People's Republic of China

650404-001 Top cover without fingerprint reader (includes TouchPad assembly)

650405-001 Webcam module

651761-001 Top cover with fingerprint reader (includes TouchPad assembly)

656796-001 System board (includes Intel Core i3-2310M, Dual-Core, 2.10 GHz, 3 MB L3 cache, 4 threads (35 W) and
replacement thermal material)—for Russia and the People's Republic of China only

656797-001 System board (includes Intel Core i5-2520M, Dual-Core, 2.50 GHz (Turbo up to 3.20 GHz), 3 MB L3
cache, 4 threads (35 W) and replacement thermal material)}—for Russia and the People's Republic of
China only
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:
e Flat-bladed screwdriver

° PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

@NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

/\ CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/\ CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400 V
Removing DIPS from plastic tube 2,000 V 700 V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000V 3,500V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000V 11,000 V 5,000V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.
Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.

Preliminary replacement requirements
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm £10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This section provides removal and replacement procedures.

There are as many as 65 screws, in 6 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag

When you order parts or request information, provide the computer serial number and model number
provided on the service tag, located inside the battery bay.
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Component

Description

(1)

Product name

The product name affixed to the front of the computer.

()

Serial number

An alphanumeric identifier that is unique to each product.

()

Product part number

The identifier that provides specific information about the product's hardware
components. The part number helps a service technician to determine what
components and parts are needed.

(4)

Warranty

The duration of the warranty period for this computer.

Component replacement procedures
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Battery

Description Spare part number

4-cell, 41-Wh (2.8-Ah) Li-on battery 635146-001

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1. Position the computer upside down on a flat surface with the front toward you.

2. Slide the battery cover release latch (1), and then rotate the edge (2) of the cover upward until
the tabs on the opposite edge disengage from the chassis.

3.  Remove the cover (3).

4. Slide the battery lock latch (1) inward. The latch opening is marked red to indicate that the latch
is unlocked.

5. Slide the battery release latch (2) inward and hold it in place as you rotate the edge of the
battery (3) upward.
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6. Then remove the battery from the battery bay (4).

© S

Reverse this procedure to install the battery.
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Service access cover

@NOTE: The service access cover is included in the Plastics Kit, spare part number 650395-001.

Before removing the service access cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

Remove the service access cover:
1. Position the computer upside down, with the service access cover toward you.
2. Loosen the three captive Phillips M6.0 x 2.5 screws (1) on the service access cover.

3. Then rotate the edge (2) of the cover upward, and remove the cover (3).

Reverse this procedure to install the service access cover.
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SIM

E%?NOTE: This section applies only to select models with WWAN capability.

E’%NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).
Remove the SIM:

1. Position the computer upside down with the front of the computer toward you.
2. Pressin on the SIM (1) to release it from the SIM slot.
3.  Remove the SIM from the slot (2).

Reverse this procedure to install the SIM.
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Memory module

Description Spare part number

Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared)

1024-MB 639736-001
2048-MB 581096-001
4096-MB 621568-001

Before removing the memory module, follow these steps:

1.

4,
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the memory module:

1.
2,

3.

Position the computer upside down with the front toward you.

Pull away the retention clips (1) on each side of the memory module to release the memory
module. (The memory module tilts up.)

/\ CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch

the components on the memory module.

Remove the memory module (2) by pulling the module away from the slot at an angle.

|‘__°:"/%9NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion.

Reverse this procedure to install a memory module.
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WLAN module

Description Spare part number

Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter for use in Australia, Bangladesh, Bhutan, Brunei, 593836-001
Cambodia, East Timor, Fiji, Hong Kong, India, Indonesia, Japan, Kiribati, Laos, Malaysia, Maldives,

Marshall Islands, Micronesia, Nauru, Nepal, New Zealand, Pakistan, Palau, Papua New Guinea,

the People's Republic of China, the Philippines, Samoa, Singapore, Solomon Islands, South Korea,

Sri Lanka, Taiwan, Thailand, Tonga, Tuvalu, and Vietnam

Broadcom 43224 802.11a/b/g/n WiFi Adapter for use in Antigua and Barbuda, Barbados, Belize, 582564-001
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands,
and the United States

Broadcom 43224 802.11a/b/g/n WiFi Adapter for use in Albania, Algeria, Angola, Argentina, 582564-002
Australia, Austria, Bahrain, Bangladesh, Belarus, Belgium, Benin, Bolivia, Botswana, Brunei,
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic,
Chad, Chile, Colombia, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, Dominican Republic, Ecuador, Egypt, El Salvador, Equitorial Guinea, Estonia,
Finland, France, Gabon, Gambia, Germany, Ghana, Gibraltar, Greece, Guinea, Guinea-Bissau,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, ltaly, the Ivory Coast, Japan, Grenada,
Guatemala, Guyana, Honduras, Jordan, Kenya, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon,
Liberia, Liechtenstein, Lithuania, Luxembourg, Madagascar, Malaysia, Mali, Mauritania, Mauritius,
Mexico, Morocco, Mozambique, Namibia, Nepal, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, the People's Republic of China, Peru, the
Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, Russia, Rwanda, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia and Montenegro, Sierra Leone, Singapore, Slovakia,
Slovenia, South Africa, South Korea, Spain, Sri Lanka, Suriname, Sweden, Switzerland, Taiwan,
Tanzania, Thailand, Togo, Tunisia, Turkey, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Venezuela, Vietnam, Yemen, and Zimbabwe

Intel Centrino® Advanced N 6205 802.11a/b/g/n, 2x2 WiFi Adapter 631954-001

/\ CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the service access cover (see Service access cover on page 38).

Remove the WLAN module:

1. Position the computer upside down with the front toward you.
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2. Remove the protective sleeves from the WLAN antennas.

3. Disconnect the WLAN antenna cables from the terminals on the WLAN module.

E’%NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal.
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4. Remove the Phillips M2.0%3.0 screw that secures the WLAN module to the system board. (The
WLAN module tilts up.)

5. Remove the WLAN module (1) by pulling the module away from the slot at an angle.

@NOTE: WLAN modules are designed with a notch (2) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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WWAN module

@NOTE: Only select models include a WWAN module (see Product description on page 1).

Description Spare part number
HP hs2340 HSPA+ Mobile Broadband Module 632155-001
HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

ACAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WWAN module, follow these steps:

1.

4,
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the WWAN module:

1.

Position the computer upside down with the front toward you.
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2,

3.

Disconnect the WWAN antenna cables from the terminals on the WWAN module.

@NOTE: The red WWAN antenna cable is connected to the WLAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

Remove the Phillips M2.0x3.0 screw (1) that secures the WWAN module to the system board.
(The WWAN module tilts up.)
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4. Remove the WWAN module (1) by pulling the module away from the slot at an angle.

E%NOTE: WWAN modules are designed with a notch (2) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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Hard drive

E%?NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
650373-001.

Description Spare part number

9.5 mm, 6.35 cm (2.5 in) hard drives:

500 GB 7200-rpm 634925-001
320 GB 7200-rpm, Self Encrypting 626978-001
320 GB 7200-rpm 641672-001
250 GB 7200-rpm 635225-001

7-mm, 6.35 cm (2.5 in) hard drives:

320 GB 7200-rpm, Self Encrypting 641674-001
320 GB 7200-rpm 634862-001
250 GB, 7200-rpm 634861-001

6.35 cm (2.5 in) solid-state drive:

128 GB 650401-001

Before removing the hard drive, follow these steps:

1.

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the hard drive:

1.

Position the computer upside down with the front toward you.
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2. Loosen the three Phillips M10.0x2.5 captive screws that secure the hard drive to the computer.

3. Grasp the tab (1) on the hard drive, pull the hard drive to the left, and then remove the hard drive
(2) at an angle.

4. Ifitis necessary to replace the hard drive bracket, follow these steps:

a. Remove the four Phillips M3.0%3.0 hard drive bracket screws (1) from the sides of the hard
drive.
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b. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Keyboard

@NOTE: The keyboard spare part kit includes a keyboard cable.

Description Spare part number
Keyboard

For use in Adriatic countries 650377-BA1
For use in Africa—French/Arabic 650377-DW1
For use in Belgium 650377-A41
For use in Bulgaria 650377-261
For use in the Czech Republic and Slovakia 650377-A81
For use in Denmark 650377-081
For use in France 650377-051
For use in French Canada 650377-121
For use in Germany 650377-041
For use in Greece 650377-DJ1
For use in Hungary 650377-211
For use in Iceland 650377-DD1
For International use 650377-B31
For use in Israel 650377-BB1
For use in Italy 650377-061
For use in Japan 650377-291
For use in Latin America 650377-161
For use in Norway 650377-091
For use in Portugal 650377-131
For use in Russia 650377-251
For use in Saudi Arabia 650377-171
For use in South Korea 650377-AD1
For use in Spain 650377-071
For use in Sweden and Finland 650377-B71
For use in Switzerland 650377-BG1
For use in Taiwan 650377-AB1
For use in Thailand 650377-281
For use in Turkey 650377-141
For use in the United Kingdom 650377-031
For use in the United States 650377-001
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Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

Remove the keyboard:

1. Position the computer upside down with the front toward you.

2. Remove the two Phillips M2.0x2.5 screws (1) in the battery bay and one T8 4.0x2.5 screw (2) in
the fan compartment.

@
T
|

3. Turn the computer right-side up, and then open the display.
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4. Carefully position the open computer on its left side, and then insert a finger into the finger hole
in the battery bay, and press on the keyboard until it disengages from the base enclosure.

Turn the computer right-side up, with the front toward you.
Rotate the keyboard forward until it rests upside down on the palm rest (1).
Open the keyboard cable zero insertion force (ZIF) connector (2).

Open the keyboard backlight cable ZIF connector (3) and remove the cable (4).

© © N o o

Remove the keyboard (5).

Reverse this procedure to install the keyboard.
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Fan

Description Spare part number

Fan

650371-001

Before removing the fan, follow these steps:

1.

5.
6.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the keyboard (see Keyboard on page 50).

Remove the fan:

1.
2.

3.
4.
5.

Position the computer upside down on a flat surface.

Disconnect the display cable (1), remove the four T8 2.5x3.0 screws (2), and then remove the
fan plate (3).

T
|

Position the computer right-side up, and open the display panel.
Open the power button cable ZIF connector (1) and remove the cable (2).

Disconnect the fan cable (3) from the system board.
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6. Remove the four T8 2.5x3.0 screws (4) from the fan assembly, and then remove the fan
assembly (5) from the base enclosure.

Reverse this procedure to install the fan assembly.
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Top cover

Description Spare part number

Top cover

NOTE: The top cover kit includes the TouchPad assembly.

With

fingerprint reader 651761-001

Without fingerprint reader 650404-001

Before removing the top cover, follow these steps:

1.

5.
6.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the keyboard (see Keyboard on page 50).

Remove the fan (see Fan on page 53).

Remove the top cover:

1.
2.
3.

Position the computer right-side up, with the display open.
Open the TouchPad cable ZIF connector (1) and disconnect the cable (2).

Open the TouchPad button cable ZIF connector (3) and disconnect the TouchPad button cable

(4).

Open the fingerprint reader cable ZIF connector (5) and disconnect the cable (6).
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5.  Open the activity button cable ZIF connector (7) and disconnect the cable (8).

6. Remove the three T8 2.5x4.0 screws under the keyboard front edge.
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7. Turn the computer over and remove the four T8 2.5x3.0 screws from the rear of the computer,
three T8 2.5x3.0 screws from the hard drive bay, and four T8 2.0x4.0 screws from the front edge
of the computer.

8. Turn the computer right-side up, open the display, and then disengage the top cover from the
base enclosure by lifting along the left and front edges and prying up the inside right edge.

9. Rotate the top cover (1) to the right, open the audio board cable ZIF connector (2), and
disconnect the cable (3).
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10. Remove the top cover (4).

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number

Power button board (includes cable) 650392-001

Before removing the power button board, follow these steps:

1.

d

4
5
6.
7
8

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the keyboard (see Keyboard on page 50).

Remove the fan (see Fan on page 53).

Remove the top cover (see Top cover on page 55).

Remove the power button board:

1.

Position the top cover upside down on a flat surface, with the front toward you. The power button

board is located in the top right corner of the top cover.

Remove the T8 2.5x4.0 screw (1) and lift the power button board (2) straight up from the top
cover.

Reverse this procedure to install the power button board.
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Activity button board

Description Spare part number

Activity button board (includes cable) 650393-001

Before removing the activity button board, follow these steps:

1.

w

4
5
6.
7
8

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the keyboard (see Keyboard on page 50).

Remove the fan (see Fan on page 53).

Remove the top cover (see Top cover on page 55).

Remove the activity button board:

1.

Position the top cover upside down on a flat surface, with the front toward you. The activity
button board is located at the top left of the top cover.

Remove the T8 2.5x4.0 screw (1) and lift the activity button board (2) straight up from the top
cover.

1

©

Reverse this procedure to install the activity button board.
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Audio board

Description Spare part number

Audio board (includes cable) 650394-001

Before removing the audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

d

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the fan (see Fan on page 53).

4
5
6. Remove the keyboard (see Keyboard on page 50).
7
8

Remove the top cover (see Top cover on page 55).

Remove the audio board:

1. Position the top cover upside down on a flat surface, with the front toward you. The audio board
is located at the front left of the top cover.

2. Remove the T8 2.5x4.0 screw (1) and lift the audio board (2) straight up from the top cover.

Reverse this procedure to install the audio board.
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Bluetooth module

Description Spare part number

Bluetooth module 537921-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 650369-001. See Cable
Kit on page 23) for more Cable Kit spare part information.

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

od

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

4

5

6. Remove the keyboard (see Keyboard on page 50).
7. Remove the fan (see Fan on page 53).

8

Remove the top cover (see Top cover on page 55).

Remove the Bluetooth module:
1. Position the computer right-side up, with the front toward you.
2. Remove the Bluetooth module bezel (1) from the base enclosure.

3. Remove the Bluetooth module (2) from the Bluetooth module bezel.
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4. Disconnect the Bluetooth cable (3) from the Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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RTC battery

Description Spare part number

RTC battery 650398-001

Before removing the RTC battery, follow these steps:

1.

w

4
5
6.
7
8

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the keyboard (see Keyboard on page 50).

Remove the fan (see Fan on page 53).

Remove the top cover (see Top cover on page 55).

Remove the RTC battery:

Position the computer right-side up, with the front toward you.

Use a thin, nonconductive tool to release the clip that secures the battery to the system board.

Remove the battery.

To install the RTC battery, press it down into the socket until it is seated.
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Speakers

Description Spare part number

Speakers 650400-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

d

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the fan (see Fan on page 53).

4
5
6. Remove the keyboard (see Keyboard on page 50).
7
8

Remove the top cover (see Top cover on page 55).

Remove the speakers:
1. Position the computer right-side up, with the front toward you.
Disconnect the speaker cable (1) from the system board.

2
3. Remove the four Phillips M2.5x2.5 screws (2) that secure the speakers to the base enclosure.
4

Gently lift up on the edge of the system board above the left speaker (3), and then lift the
speakers straight up from the base enclosure (4).

Reverse this procedure to install the speakers.
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System board

Description Spare part number

System board (includes replacement thermal material)

e Includes Intel Core i3-2310M, Dual-Core, 2.10 GHz, 3 MB L3 cache, 4 threads (35 W)—for 650402-001
all countries except Russia and the People's Republic of China

e Includes Intel Core i5-2520M, Dual-Core, 2.50 GHz (Turbo up to 3.20 GHz), 3 MB L3 cache, 650403-001
4 threads (35 W)—for all countries except Russia and the People's Republic of China

e Includes Intel Core i3-2310M, Dual-Core, 2.10 GHz, 3 MB L3 cache, 4 threads (35 W)--for 656796-001
Russia and the People's Republic of China only

e Includes Intel Core i5-2520M, Dual-Core, 2.50 GHz (Turbo up to 3.20 GHz), 3 MB L3 cache, 656797-001
4 threads (35 W) --for Russia and the People's Republic of China only

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

w

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the fan (see Fan on page 53).

4
5
6. Remove the keyboard (see Keyboard on page 50).
7
8. Remove the top cover (see Top cover on page 55).
9

Remove the speakers (see Speakers on page 65).

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

e  Memory module (see Memory module on page 40)
e  WLAN module (see WLAN module on page 41)
e  WWAN module (see WWAN module on page 44)

e SIM (see SIM on page 39)

e Fan (see Fan on page 53)
e RTC battery (see RTC battery on page 64)

Remove the system board:

1. Position the computer right-side up, with the front toward you.
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2. Remove the three T8 2.5x4.0 screws (marked with triangles) that secure the system board to the
base enclosure.

3. Rotate the system board to the right (1).

4. Disconnect the power cable (2) from the system board, and then remove the system board (3).

Reverse this procedure to install the system board.
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Heat sink

Description Spare part number

Heat sink (includes replacement thermal material) 650372-001

Before removing the heat sink, follow these steps:

1.

w
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10.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the keyboard (see Keyboard on page 50).

Remove the fan (see Fan on page 53).

Remove the top cover (see Top cover on page 55).

Remove the speakers (see Speakers on page 65).

Remove the system board (see System board on page 66).

Remove the heat sink:

1.
2,
3.

Position the system board upside down on a flat surface.
Loosen the four captive screws (1) that secure the heat sink to the system board.

Lift the heat sink straight up (2) and remove it from the system board.

@NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
components (1) and (2), and the system board components (3) and (4), each time the heat sink is
removed. Replacement thermal material is included with all heat sink and system board spare part

kits.
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Reverse this procedure to install the heat sink.
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Power connector cable

@NOTE: The power connector cable is included in the Cable Kit, spare part number 650369-001. For
more Cable Kit spare part information, see Cable Kit on page 23.

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

od

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the service access cover (see Service access cover on page 38).

Remove the keyboard (see Keyboard on page 50).

Remove the fan (see Fan on page 53).

Remove the top cover (see Top cover on page 55).
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Remove the speakers (see Speakers on page 65).

10. Remove the system board (see System board on page 66).

Remove the power connector cable:
1. Position the computer right-side up, with the front toward you.
2. Remove the WWAN and WLAN cables (1) from the routing channels in the base enclosure.

3.  Remove the T8 2.5x3.0 screw (2) that secures the power connector bracket to the base
enclosure.

4. Remove the power connector bracket (3) from the base enclosure.
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5. Remove the power connector and cable (4) by lifting them straight up from the base enclosure.

Reverse this procedure to install the power connector cable.
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Display panel

Description Spare part number
Display bezel 650368-001
33.8 cm (13.3 in) High-Definition (HD) AntiGlare LED display (1280x800) 650397-001

=~¢NOTE: If you need to remove only the display panel, not the complete display assembly, follow the
steps in this section. To remove the complete display assembly, omit this section and follow the
procedures in Display assembly on page 75.

Before removing the display panel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

Remove the display panel:

1. Position the computer right-side up on a flat surface, with the display open.

2. Flex the top (1) of the bezel from the inside edge until it disengages from the display back cover.

3. Flex the inside edge of the left side and the right side (2) of the bezel until they disengage from
the display back cover.

4. Flex the bottom (3) of the bezel from the inside edge until it disengages from the display back
cover.
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5. Remove the display bezel from the display back cover (4).

-

6. Position the computer with the display assembly on a flat surface and the keyboard open at a
90-degree angle.

7. Disconnect the webcam cable (1) and remove the four Phillips M2.0x3.0 screws (2) that secure
the display panel to the hinge brackets.

8. Lift the display panel (1) toward the keyboard, and then peel the webcam cable (2) from the back
of the display panel.
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9. Peel the adhesive from the back of the display panel (3), disconnect the display cable (4), and
then remove the display panel (5).

Reverse this procedure to install the display panel.
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Display assembly

Description Spare part number
Display bezel 650368-001
Webcam module 650405-001
Display Hinge Kit (includes left and right display hinges) 650374-001
Display hinge covers 650376-001

WLAN antennas and cables (included in the Antenna Kit, spare part number 650365-001)

WWAN antennas and cables (included in the Antenna Kit, spare part number 650365-001)

Display back cover 650366-001

E‘%NOTE: Removing the display panel is not required to remove the display assembly. If it is
necessary to remove the wecam module, WLAN module, or WWAN module, remove the display
bezel for access to those components. For display bezel removal instructions, see Display panel

on page 72.

Before removing the display assembly, follow these steps:

1.

il

4
5
6
7.
8
9
1

1

12.

0.
1

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

(Optional) Remove the display panel (see Display panel on page 72).

Remove the service access cover (see Service access cover on page 38).

Remove the keyboard (see Keyboard on page 50).

Remove the fan (see Fan on page 53).

Remove the top cover (see Top cover on page 55).

Remove the speakers (see Speakers on page 65).

Remove the system board (see System board on page 66).

Remove the power connector cable (see Power connector cable on page 70).

Remove the display assembly:

1.

Position the computer right-side up, with the front toward you.
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2. Feed the display cable (1) through the bottom of the base enclosure, and then remove the
WLAN and WWAN cables (2) from the base enclosure routing channels.

|

/\ CAUTION: Support the display assembly when removing the display screws in the following

steps. Failure to support the display assembly can result in damage to the assembly and other
components.

3.  Remove the four T8 2.5x4.0 screws (1) that secure the display assembly hinges to the base
enclosure.

4. Lift the display assembly (2) straight up and remove it from the base enclosure.
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5. Ifitis necessary to replace the webcam module, position the display assembly on a flat surface.
Gently pull the webcam module away from the double-sided tape on the display back cover and
remove the webcam.

|

|

|

|

|

|

I -
-

6. Ifitis necessary to replace the display hinges, remove the three T8 2.5x3.0 screws (1) that
secure the hinge covers to the display back cover.

7. Insert a small tool (2) under each hinge cover, and then apply upward pressure to disengage the
hinge cover (3).

E%‘fNOTE: Be careful not to scratch the silver paint when removing the display hinge covers.

8. Remove the four T8 2.5x4.0 screws on the bottom corners and the two T8 2.5x3.0 screws (1) on
the upper corners of the display hinges that secure the display hinges to the display assembly
back cover.
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9. Remove the display hinges from the display back cover (2).

10. Ifitis necessary to replace the display webcam cable, lift it straight up from the display back
cover.
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11. Ifitis necessary to replace the WWAN antenna cables, detach the WWAN antenna transceivers
from the adhesive on the back cover, remove the cables from the clips that secure them to the
display back cover, and then remove the WWAN antenna cables.

12. Ifitis necessary to replace the WLAN antenna cables, detach the WLAN antenna transceivers
from the adhesive on the back cover, remove the cables from the clips that secure them, and
then remove the WLAN antenna cables.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup

Computer Setup in Windows 7
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

@NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

@NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.
Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

¢ NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

E%?NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o &~ @ N

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E‘%NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

your computer.

E/?’NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by

File menu

Select

To do this

System Information

e View identification information for the computer and the
batteries in the system.

e View specification information for the processor,
memory size, system ROM, video revision, keyboard
controller version, and wireless identification numbers.

Set System Date and Time

Set or change the date and time on the computer.

System Diagnostic

Display the following information:
e  System Information

° Identification information for the computer and the
batteries in the system.

° Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

e  Start-up Test: verifies the system components needed
for starting the computer.

e Runin Test: runs a comprehensive check on system
memory.

e  Hard Disk Test: runs a comprehensive self-test on any
hard drive in the system.

e  Memory Test: runs a comprehensive test on any
memory installed in the computer.

e  Battery Test: runs a comprehensive test on any
batteries installed in the computer.

e  Error Log: displays a log file if any errors have occurred.

Restore Defaults

Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default

Resets password to the factory default in case of a forgotten
password.

Ignore Changes and Exit

Cancel any changes entered during the current session.
Then exit and restart the computer.

Save Changes and Exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

r__i"%NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management (requires a BIOS administrator password)

e  Create a new BIOS user account.

e View a list of HP ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment

Enable/disable HP SpareKey enroliment (enabled by
default).

Anti Theft (select models only)

Enable/disable anti-theft protection.

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (disabled by
default).

Allow reset of HP ProtectTools security keys

Enable/disable reset of HP ProtectTools security keys.

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords

e  Enable/disable DriveLock on any computer hard drive
(enabled by default).

e  Change a DriveLock user password or master
password.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock

Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive.
CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and

ownership tag.

System Configuration menu

E%?NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language

Change the Computer Setup language.

Computer Setup in Windows 7
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Select

To do this

Boot Options

e  Seta Startup Menu delay (in seconds).
e  Set the MultiBoot Express Boot Popup delay in seconds.
e Enable/disable Custom Logo (disabled by default).

e  Enable/disable Display Diagnostic URL (enabled by
default).

e Enable/disable CD-ROM boot (enabled by default).
e Enable/disable SD Card boot (enabled by default).
e  Enable/disable floppy boot (enabled by default).

e Enable/disable PXE Internal NIC boot (enabled by
default).

° Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

e  Set the Express Boot Popup delay in seconds.

e  Set the boot order.

Device Configurations

e  Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or external optical drive
connected by a USB port to the computer.

e  Enable/disable fan always on while connected to an AC
outlet (enabled by default).

e Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

e  Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN
when not in use (enabled by default).

e  SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

° AHCI (Advanced Host Controller Interface)

° IDE (Integrated Drive Electronics)
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Select To do this

NOTE: Auvailability of the options above varies by
computer model.

e  Enable/disable HP DayStarter (enabled by default).
e  Enable/disable HP QuickLook (enabled by default).

e  Enable/disable Preboot Authentication on HP QuickLook
Boot (disabled by default).

e Enable/disable Virtualization Technology (select models
only; disabled by default).

e  Enable/disable HP QuickWeb (enabled by default).

e  Enable/disable HP QuickWeb write protect (disabled by
default).

e  Enable/disable Multi Core CPU (enabled by default).

e  Enable/disable Intel® HT Technology (enabled by
default).

e Enable/disable wake on USB (enabled by default).

e  Enable/disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

e  Turn the Numlock state at boot on or off.
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Select To do this

Built-in Device Options °

Enable/disable the wireless button state (enabled by
default).

Enable/disable the embedded WLAN device (enabled by
default).

Enable/disable embedded WWAN device radio (select
models only; enabled by default).

Enable/disable embedded Bluetooth® device radio
(enabled by default).

Enable/disable the Network Interface Controller (LAN)
(enabled by default).

Enable/disable LAN/WLAN switching (disabled by
default).

Set the wake on LAN state. Options include the
following:

° Disabled
° Boot to Network (set by default)
° Follow Boot Order

Enable/disable the fingerprint device (enabled by
default).

Enable/disable a modem device (enabled by default).
Enable the ambient light sensor (enabled by default).

Enable/disable the Notebook MultiBay device (enabled
by default).

Enable/disable the integrated camera (select models
only; enabled by default).

Enable/disable the power monitor circuit (enabled by
default).

Enable/disable the audio device (enabled by default).
Enable/disable optical disc drive (enabled by default).
Enable/disable internal microphone (enabled by default).

Enable/disable the internal speakers (enabled by
default).

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

Enable/disable the smart card slot.
Enable/disable the flash media reader.
Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices on the advanced port replicator.

Enable/disable the 1394 port.
Enable/disable the eSATA port.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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Computer Setup in Windows Vista
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

E‘%NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

@NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

@NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.
3. Select the File, Security, Diagnostics, or System Configuration menu.
To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
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Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

@NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1.

o & 0N

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.
Follow the on-screen instructions.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

=¥ NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

88 Chapter5 Computer Setup



Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

E’%NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by

your computer.

File menu

Select

To do this

System Information

View identification information for the computer and the
batteries in the system.

View specification information for the processor,
memory size, system ROM, video revision, keyboard
controller version, and wireless identification numbers.

Set System Date and Time

Set or change the date and time on the computer.

System Diagnostic

Display the following information:

System Information

° Identification information for the computer and the
batteries in the system.

° Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

Start-up Test: verifies the system components needed
for starting the computer.

Run in Test: runs a comprehensive check on system
memory.

Hard Disk Test: runs a comprehensive self-test on any
hard drive in the system.

Memory Test: runs a comprehensive test on any
memory installed in the computer.

Battery Test: runs a comprehensive test on any
batteries installed in the computer.

Error Log: displays a log file if any errors have occurred.

Restore Defaults

Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default

Resets password to the factory default in case of a forgotten
password.

Ignore Changes and Exit

Cancel any changes entered during the current session.
Then exit and restart the computer.

Save Changes and Exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

@NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management (requires a BIOS administrator password)

e  Create a new BIOS user account.

e View a list of HP ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enroliment

Enable/disable HP SpareKey enroliment (enabled by
default).

Anti Theft (select models only)

Enable/disable anti-theft protection.

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (disabled by
default).

Allow reset of HP ProtectTools security keys

Enable/disable reset of HP ProtectTools security keys.

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords

e  Enable/disable DriveLock on any computer hard drive
(enabled by default).

e Change a DrivelLock user password or master
password.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock

Enable/disable Automatic DriveLock support.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

System Configuration menu

@NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language

Change the Computer Setup language.
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Select

To do this

Boot Options

e  Set a Startup Menu delay (in seconds).

e  Set the MultiBoot Express Boot Popup delay in
seconds.

e  Enable/disable Custom Logo (disabled by default).

e  Enable/disable Display Diagnostic URL (enabled by
default).

e Enable/disable CD-ROM boot (enabled by default).
e Enable/disable SD Card boot (enabled by default).
e  Enable/disable floppy boot (enabled by default).

e  Enable/disable PXE Internal NIC boot (enabled by
default).

e Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

e  Set the Express Boot Popup delay in seconds.

° Set the boot order.

Device Configurations

e  Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

° Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not
running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or external optical drive
connected by a USB port to the computer.

e  Enable/disable fan always on while connected to an AC
outlet (enabled by default).

° Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

e  Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN
when not in use (enabled by default).

e  SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

° AHCI (Advanced Host Controller Interface)

° IDE (Integrated Drive Electronics)
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Select

To do this

NOTE: Availability of the options above varies by
computer model.

e Enable/disable HP DayStarter (enabled by default).
e  Enable/disable HP QuickLook (enabled by default).

e  Enable/disable Preboot Authentication on HP
QuickLook Boot (disabled by default).

e  Enable/disable Virtualization Technology (select models
only; disabled by default).

e  Enable/disable HP QuickWeb (enabled by default).

e  Enable/disable HP QuickWeb write protect (disabled by
default).

e  Enable/disable Multi Core CPU (enabled by default).

e  Enable/disable Intel® HT Technology (enabled by
default).

e Enable/disable wake on USB (enabled by default).

e  Enable/disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

e  Turn the Numlock state at boot on or off.
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Select

To do this

Built in Device Options

Enable/disable the wireless button state (enabled by
default).

Enable/disable the embedded WLAN device (enabled
by default).

Enable/disable embedded WWAN device radio (select
models only; enabled by default).

Enable/disable embedded Bluetooth® device radio
(enabled by default).

Enable/disable the Network Interface Controller (LAN)
(enabled by default).

Enable/disable LAN/WLAN switching (disabled by
default).

Set the wake on LAN state. Options include the
following:

° Disabled
° Boot to Network (set by default)
° Follow Boot Order

Enable/disable the fingerprint device (enabled by
default).

Enable/disable a modem device (enabled by default).
Enable the ambient light sensor (enabled by default).

Enable/disable the Notebook MultiBay device (enabled
by default).

Enable/disable the integrated camera (select models
only; enabled by default).

Enable/disable the power monitor circuit (enabled by
default).

Enable/disable the audio device (enabled by default).
Enable/disable optical disc drive (enabled by default)..

Enable/disable internal microphone (enabled by
default).

Enable/disable the internal speakers (enabled by
default).

Port Options (all are enabled by default)

NOTE: All port options are enabled by default.

Enable/disable the smart card slot.
Enable/disable the flash media reader.
Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices on the advanced port replicator.

Enable/disable the 1394 port.
Enable/disable the eSATA port.
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Select To do this

Set Security Level Change, view, or hide security levels for all BIOS menu
items.
Restore Security Defaults Restore the default security settings.

Computer Setup in Linux
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

= NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer or your operating system.

= NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to
navigate and make selections.

=2 NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before your operating system opens and while the “F10=ROM Based Setup” message is
displayed in the lower-left corner of the screen, press f10.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

e To choose a menu or a menu item, use the arrow keys.
e To select an item, press enter.

e To close open dialog boxes and return to the main Computer Setup screen, press esc.
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e To view navigation information, press f1.

e To change the language, press f2.
2. Select the File, Security, Diagnostics, or System Configuration menu.
3. To exit Computer Setup, choose one of the following methods:

e To exit Computer Setup without saving your preferences, use the arrow keys to select
File > Ignore Changes And Exit. Then follow the instructions on the screen.

e To save your preferences and exit Computer Setup, use the arrow keys to select File >
Save Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press enter.
3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

E’%NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

E’%NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer or your operating system.

File menu

“»NOTE: Some of the menu items listed in this section may not be supported by your computer or
your operating system.

Select To do this

System information e View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)
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Select To do this

Ignore Changes And Exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.

Security menu

2 NOTE: Some of the menu items listed in this section may not be supported by your computer or
your operating system.

Select To do this
Setup Password Enter, change, or delete a setup password.
Password Options e  Enable/disable stringent security.

e Enable/disable the password requirement on computer
restart.

DriveLock Passwords e  Enable/disable DriveLock on any computer hard drive.

e  Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e  Fast: Runs the Disk Sanitizer erase cycle once.
e  Optimum: Runs the Disk Sanitizer erase cycle 3 times.

e  Custom: Allows you to select the desired number of
Disk Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

Diagnostics menu

= NOTE: Some of the menu items listed in this section may not be supported by your computer or
your operating system.

Select To do this

HDD Self-Test Options Run a comprehensive self-test on any hard drive in the
system or on any optional MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.
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System Configuration menu

E%NOTE: Some of the menu items listed in this section may not be supported by your computer or

your operating system.

Select To do this
Language Change the Computer Setup language.
Boot options e Setanf9, f10, and f12 delay when starting up.

Enable/disable CD-ROM boot.
Enable/disable floppy boot.
Enable/disable internal network adapter boot.

Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

Set the Express Boot Popup delay in seconds.
Set the boot order.

° 1st boot device: USB CD-ROM

° 2nd boot device: USB floppy

° 3rd boot device: USB SuperDisk

° 4th boot device: Notebook hard drive

° 5th boot device: USB hard disk

° 6th boot device: Network controller

Device Configurations °

Swap the functions of the fn key and left ctrl key.

Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

0 Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

Enable/disable BIOS DMA data transfers.

Enable/disable fan always on while connected to an AC
outlet.

Enable/disable data execution prevention.
Enable/disable LAN power saving mode.
Enable/disable SATA Native Mode.
Enable/disable Dual Core CPU.

Enable/disable HDD translation mode.
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Select

To do this

Built in device options

Enable/disable embedded WLAN Device Radio.
Enable/disable embedded Bluetooth Device Radio.
Enable/disable Network Interface Controller (NIC)
Enable/disable LAN/WLAN Switching.
Enable/disable Wake on LAN.

Enable/disable the integrated camera (webcam)

Port options

Enable/disable USB port.

Enable/disable ExpressCard slot.
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6 Specifications

Computer specifications

Dimensions
Depth 22.5cm (8.8 in)
Width 32.8 cm (12.9in)

Height (front to rear)

25.2 mm (0.99 in)

Weight

Computer equipped with a 4-cell battery, 128 MB solid-state drive, one
memory module, and 33.8 cm (13.3 in) display panel

1.81 kg (3.99 Ibs)

Input power

Operating voltage

18.5Vdc@4.74 A-90 W

Operating current 474 A
Temperature
Operating 5°C to 35°C (41°F to 95°F)

Nonoperating

-20°C to 60°C (-4°F to 140°F)

Relative humidity (non-condensing)

Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)

Operating

-15 m to 3,048 m (-50 ft to 10,000 ft)

Nonoperating

-15 m to 12,192 m (-50 ft to 40,000 ft)

Shock

Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration

Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25
oct/min sweep rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/
min sweep rate

NOTE: Applicable product safety standards specify thermal limits for
plastic surfaces. The computer operates well within this range of
temperatures.
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33.8 cm (13.3 in) display specifications

Dimensions

Height 16.3 cm (6.4 in)
Width 26.1 cm (10.3in)
Diagonal 33.8cm (13.3in)

Number of colors

Up to 16.8 million

Contrast ratio

300:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch 0.204 x 0.204 mm
Format SD: 1280x800
Configuration RGB vertical stripe
Backlight LED

Character display 80 x 25

Total power consumption 40W

Viewing angle

+30° horizontal, £10° vertical (minimum)
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Hard drive specifications

500 GB* 320 GB* 250 GB* 128 GB SSD*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 6.35 mm
Width 70 mm 70 mm 70 mm 70 mm
Weight 115¢ 115¢g 115¢g 86 g
Interface type SATA SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security ATA security
Seek times (typical read, including
setting)
Single track 20ms 2.0ms 2.0 ms
Average 12.0 ms 12.0 ms 12.0 ms
Maximum 22.0 ms 22.0ms 22.0ms
Logical blocks 976,773,168 625,142,448 488,397,168 156,301,488
Disc rotational speed 7200 rpm 7200 rpm 7200 rpm
Operating temperature 0°C to 60°C (32°F 0°C to 60°C (32°F  0°C to 60°C (32°F  0°C to 70°C (32°F
to 140°F) to 140°F) to 140°F) to 158°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Windows 7 backup and recovery

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only),
or create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:
e Creating a system repair disc (select models only)

e  Backing up individual files and folders

e Creating a system image (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e Recovering individual files

e Restoring the computer to a previous state

e  Recovering information using recovery tools

@NOTE: For detailed instructions, perform a search for these topics in Help and Support.

=?NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e  When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of external optical drive attached to your computer.

@NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the external optical drive
attached to your computer.

To create a backup using Backup and Restore, follow these steps:

E‘%NOTE: Be sure that the computer is connected to AC power before you start the backup process.

E’%NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

@NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support
for more information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

E’%NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.
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Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

E/?’NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.

To recover your information using Startup Repair, follow these steps:

/\ CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.
2. If possible, check for the presence of the Windows partition and the HP Recovery partition.
To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and
then click Disk Management.

E’%NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

=¥ NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

=¥ NOTE: If your computer includes a solid-state drive (SSD), you may not have a recovery partition.
Recovery discs have been included for computers that do not have a partition. Use these discs to
recover your operating system and software. To check for the presence of a recovery partition, select
Start > Computer. If the partition is present, an HP Recovery drive is listed in the Hard Disk Drives
section of the window.
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To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.

@NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press 11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows 7 operating system
DVD, go to http://www.hp.com/support, select your country or region, and then follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

@NOTE: This process takes several minutes. Before rebooting, make sure you have changed the
legacy boot order in the F10 utility so that the USB CD-ROM drive is the first choice.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the external
optical drive before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.

N o g v

Follow the on-screen instructions.

Windows Vista backup and recovery

To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), create system repair discs (select models
only), or create system restore points. In case of system failure, you can use the backup files to
restore the contents of your computer.

Windows Vista backup and recovery 105


http://www.hp.com/support

The Backup and Restore Center provides the following options:

Creating a system repair disc (select models only)
Backing up individual files and folders

Backing up the entire hard drive (select models only)
Scheduling automatic backups (select models only)
Creating system restore points

Recovering individual files

Restoring the computer to a previous state

Recovering information using recovery tools

@NOTE: For detailed instructions, perform a search for these topics in Help and Support.

=¥ NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:
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Store personal files in the Documents folder, and back it up regularly.
Back up templates that are stored in their associated programs.

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of external optical drive connected to your computer.

Backup and recovery



E/?’NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the external optical drive.

To create a backup using Backup and Restore Center, follow these steps:

E’%NOTE: Be sure that the computer is connected to AC power before you start the backup process.

E%"%NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

=¥ NOTE: Windows® includes the User Account Control feature to improve the security of your

computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

=»NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Vista operating system DVD
to reboot the computer and repair the operating system. For additional information, refer to the “Using
a Vista operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

E’%NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:
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/\ CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.

E’%NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows Vista operating system DVD and the
Driver Recovery disc (both purchased separately). For additional information, refer to the “Using
a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

@NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. Al files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.

E/?’NOTE: If your computer includes a solid-state drive (SSD), you may not have a recovery partition.
Recovery discs have been included for computers that do not have a partition. Use these discs to
recover your operating system and software. To check for the presence of a recovery partition, select
Start > Computer. If the partition is present, an HP Recovery drive is listed in the Hard Disk Drives
section of the window.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

E%?NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
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recent backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow the
on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

ACAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

E’%NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.
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Follow the on-screen instructions.

Linux backup and recovery

Use the instructions in this section if SUSE Linux SLED 11 is installed on your computer.

To protect your information, back up your files and folders. Then if the system fails, you can restore
your important files from copies. You can also use the options listed in this section to restore the
operating system and programs that were installed at the factory.

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the original operating system and HP programs and drivers that were installed
at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. Restart the computer, and then press 11 while the “Press <F11> for recovery” message is
displayed on the screen.

3. Follow the on-screen instructions.
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8 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:
e  The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e  The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
South Korea EK 4

110 Chapter 8 Power cord set requirements



Country/region Accredited agency Applicable note number

Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.  The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/\ WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

ACAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

E/?’NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

g -

=?NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

!
i-

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

/ E
® ..--

o

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

—0

|

I

I

: .
I ---..____.__

I .

13. Remove the backlight cover.
14. Turn the display panel right-side up.
15. Remove the backlight cables (1) from the clip (2) in the display panel.
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16. Turn the display panel upside down.

/\ WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.

18. Remove the backlight from the backlight frame.

— ¢

|

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.
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22. Release the tape (4) that secures the LCD panel to the display rear panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter
spare part number 25
activity button board
location 19
removal 60
spare part number 19, 60
antennas, disconnecting 42, 45
audio board
location 19
removal 61
spare part number 19, 28, 61
audio in (microphone) jack,
identifying 12
audio, product description 2
audio-out (headphone) jack,
identifying 12
Automatic DriveLock 83, 90

B
backing up
Linux 109
Windows 7 102
Windows Vista 105
Backup and Restore 102, 103
Backup and Restore Center 105,
107

base enclosure, spare part number

19

battery

removal 36

spare part number 19, 36
battery bay, identifying 15
battery cover

illustrated 22

spare part number 21
battery cover release latch 15
battery light 12
BIOS administrator password 83,

90

BIOS reset 82, 89
Bluetooth module

location 19

removal 62

spare part number 19, 62
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Bluetooth module cable 23, 62
boot options 84, 91, 97
boot order 84, 91, 97
built in device
ambient light sensor 86, 93
Bluetooth device radio 86, 93
embedded WLAN 86, 93
fingerprint reader 86, 93
integrated camera 86, 93
LAN/WLAN switching 86, 93
modem 86, 93
Network Interface Controller
(LAN) 86, 93
Notebook MultiBay 86, 93
Wake on LAN 86, 93
wireless hotkey 86, 93
WWAN device radio 86, 93
built in device options 86, 93
buttons
left TouchPad 6
power 8
right TouchPad 6

C
Cable Kit

contents 23

spare part number 23
cables, service considerations 31
caps lock light, identifying 7
chipset, product description 1
component recycling

battery 112

display 112
components
bottom 15
display 14
front 11
left side 13
right side 12
top 6

Computer Setup 80, 87
Diagnostic menu 96
File menu 82, 89, 95
navigating and selecting 80,
87,94

restoring factory settings 81,
88, 95
Security menu 83, 90, 96
System Configuration menu
83, 90, 97
computer specifications 99
connector, power 12
connectors, service
considerations 31
creating a backup 102

D
device configurations 84, 91
Diagnostic menu 96
Disk Sanitizer 83, 90
diskette drive, precautions 31
display assembly
removal 75
spare part number 75
display back cover, spare part
number 22, 27,75
display bezel
location 21
spare part number 21
display cable, spare part number
22,27
display hinge kit
location 21
spare part number 21, 27
display hinge kit, spare part
number 75

display panel
location 18
removal 72

spare part number 18, 72
display specifications 100
DriveLock password 83, 90
drives

boot order 84, 91, 97

preventing damage 31
Dual-Core CPU 85, 92
DVDxRW Double-Layer Drive

precautions 31



E

electrostatic discharge 32

embedded numeric keypad,
identifying 10

error log 82, 89

eSATA port 13

esc key, identifying 10

Ethernet, product description 2

Execution Disable 84, 91

external media cards, product
description 2

external monitor port 13

F
f11 recovery 104, 108
fan

location 18

removal 53

spare part number
fan plate, location 19
File menu 82, 89, 95
fingerprint reader, identifying 9
fn key, identifying 10
function keys, identifying 10

18, 53

G

graphics, product description 1

grounding equipment and
methods 34

H
hard disk test 82, 89
hard drive

precautions 31

product description 1

removal 47

spare part number 19, 24, 47
hard drive bay, identifying 15
hard drive light 11
hard drive recovery 104, 108
hard drive specifications 101
HDMI port, identifying 13
headphone (audio-out) jack 12
heat sink

location 19

removal 68

spare part number 19, 68
hinge covers, part number 22
HP DayStarter 85, 92
HP QuickLook 85, 92
HP QuickWeb 85, 92

HP SpareKey enrollment 83, 90

I

integrated webcam light,
identifying 14

internal display switch 14

internal microphones, identifying
14

J
jacks
audio in (microphone) 12
audio-out (headphone) 12
network 12
RJ-45 (network) 12
K
keyboard
location 18
product description 3
removal 50
spare part number 18, 50
keypad
embedded numeric 10
keys
esc 10
fn 10
function 10
Windows applications 10
Windows logo 10
L

LAN Power Save 84, 91
language, changing in Computer
Setup 83, 90
latch, battery cover release 15
legacy support, USB 80, 84, 87,
91, 94, 97
lights
battery 12
caps lock 7
hard drive 11
power 7, 11
TouchPad 7
webcam 14
wireless 7

M
mass storage devices, spare part
number 24

Media Card Reader, identifying
13
memory module
product description 1
removal 40
spare part number 20, 40
memory module compartment,
identifying 15
microphone (audio in) jack,
identifying 12
model name 1

N
network jack, identifying 12
Numlock state 85, 92

(0]

operating system, product
description 3

optical drive, precautions 31

P
packing guidelines 33
panels, product description 1
passwords 83, 90, 96
plastic parts 30
Plastics Kit
contents 22
spare part number 22
pointing devices, product
description 3
port options 86, 93
1394 port 86, 93
eSATA port 86, 93
flash media reader 86, 93
smart card slot 86, 93
USB port 86, 93
ports
external monitor 13
HDMI 13
product description 2
USB 12,13
power button board
location 19
removal 59
spare part number 19, 59, 60
power button, identifying 8
power cable, illustrated 23
power connector bracket,
location 19
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power connector cable
location 19
removal 70
power connector, identifying 12
power cord
spare part number 25
power cord set requirements 110
power lights 7, 11
power requirements, product
description 3
processor, product description 1
product description
audio 2
chipset 1
Ethernet 2
external media cards 2
graphics 1
hard drives 1
keyboard 3
memory module 1
operating system 3
panels 1
pointing devices 3
ports 2
power requirements 3
processors 1
product name 1
security 3
serviceability 5
visual 2
wireless 2
product name 1

R
recovery 103
recovery partition 104, 108
recycling, display components.
See component recycling
removal/replacement
preliminaries 30
procedures 35
restore factory settings 81, 82,
88, 89
restore hard drive 104, 108
restore security defaults 86, 94
RJ-45 (network) jack, identifying
12
RTC battery
location 19
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removal 64
spare part number
runin test 82, 89

19, 64

S
SATA (Serial Advanced
Technology Attachment)
devices 84, 91
AHCI (Advanced Host
Controller Interface) 84, 91
IDE (Integrated Drive
Electronics) 84, 91
Screw Kit, spare part number 25
SD Card blank, location 19
security cable slot, identifying 13
security defaults, restore 86, 94
security level 86, 94
Security menu 83, 90, 96
allow reset of HP ProtectTools
security keys 83, 90
always prompt for HP
SpareKey enrollment 83, 90
Anti Theft 83, 90
Automatic DriveLock 83, 90
change password 83, 90
Disk Sanitizer 83, 90
DriveLock 83, 90
fingerprint reader reset 83, 90
HP SpareKey 83, 90
HP SpareKey enroliment 83,
90
password policy 83, 90
set up BIOS administrator
password 83, 90
System IDs 83, 90
user management 83, 90
security, product description 3
service access cover
illustrated 22
removal 38
spare part number 21
service considerations 30
Service tag 35
serviceability, product
description 5
setup utility
Diagnostic menu 96
File menu 82, 89, 95
navigating and selecting 80,
87,94

restoring factory settings 81,
88, 95
Security menu 83, 90, 96
System Configuration menu
83, 90, 97
SIM
removal 39
spare part number 39
SIM slot, identifying 15

slots
security cable 13
SIM 15

solid-state drive, spare part
number 24
speakers
identifying 11
location 19
removal 65
spare part number
specifications
computer 99
display 100
hard drive 101
start-up test 82, 89
static-shielding materials 34
stringent security 96
system board
location 19
removal 66
spare part number 19, 66
System Configuration menu 83,
90, 97
system date and time 82, 89
system diagnostic 82, 89
system fan 84, 91, 97
system IDs 83, 90
system information 82, 89, 95

19, 65

-
tools required 30
top cover

location 19

removal 55

spare part number
TouchPad

buttons 6

identifying 6
TouchPad cable

illustrated 23
TouchPad light, identifying 7

19, 55



transporting guidelines 33

U

Unified Extensible Firmware
Interface (UEFI) mode 85, 92

USB legacy support 80, 84, 87,
91, 94, 97

USB ports, identifying 12, 13

Vv

vents, identifying 13, 15
Virtualization Technology 85, 92
visual, product description 2

w
webcam light, identifying 14
webcam module, spare part
number 22
webcam, identifying 14
Windows 7 operating system
DVD 105
Windows applications key,
identifying 10
Windows logo key, identifying 10
Windows Vista operating system
DvD 108
wireless antennas
disconnecting 42, 45
identifying 14
wireless compartment,
identifying 15
wireless light 7
wireless, product description 2
WLAN antennas
identifying 14
location 22
WLAN module
location 20
removal 41
spare part number 20, 41
workstation guidelines 33
WWAN antennas
identifying 14
location 22
WWAN module
location 20
removal 44
spare part number 20, 44
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